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MONITORIZA 

¿WHAT IS MONITORIZA?  

 
Monitoriza is a monitoring and control system (SCADA Supervisory Control & Data 

Acquisition) which covers the requirements of any project, both basic and advanced. 
 
Monitoriza allows us to create solutions for capturing information in industrial 
processes or any other field. With that information, the process gets a feedback and 
can be used for decision making.  
 
It consists of three parts: 
 
· A project editor for defining all the elements. 
 
· A server that will execute the project and will ensure communication with the 
process (data acquisition, process benchmarking, etc.).  
 
· A client that displays, visually, the information of the processes that are being 
monitored. 
 
Monitoriza is a flexible system in their configuration because it can be run by multiple 
users simultaneously. It can operate on a stand alone or infrastructure, on a local 
network or through remote sites connected via the Internet. 
 
Among the main features of Monitoriza can be highlighted: 
 
Å Simple and immediate product installation.  
 
Å Easy setup, even if it is a remote installation (WAN), because communications 
between client computers and server are based on Internet standards (HTTP 
protocol).  
 
Å Includes ModBUS native communications, Ethernet S7 for S7-300 and OPC 
connectivity.  
 
Å No programming required to create fully functional projects, simply "drag and 
drop" SCADA objects on the forms and set the corresponding properties for a 
working solution.  
 
Å If required advanced functionality, not covered in the objects defined in SCADA, 
there is no problem because Monitoriza can be extended by programming in C # or 
VB.Net. It is also possible to use third-party libraries developed for. NET Framework 
for Windows.  
 
Å The creation of the graphical user interface is based on technology Microsoft 
Windows Forms Designer © which greatly facilitates the design. 
 
Å At the project level, we can define users and permissions assigned to each of 
them. For example you can have only Read permissions or have full access to a 
form.  
 
Å Immediate definition of alarms.  
 
Å Effective operations monitoring.  
 
Å Increased instantaneous information.  
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Å Easy tracking for variables.  
 
Å Information in several accessible formats. Monitoriza can store monitorized 
variables in standard databases on the market (Microsoft É SQL Server Ê, 
Microsoft É Access Ê, Oracle È, etc.).  
 
Å Minimum investment and immediately redeemable.  
 
Å Definition of recipes using templates, with a user control to use recipes.  
 
Å Functions for loading batch recipes per event. 
 
Å Monitoriza provides server variables defined by OPC services and external 
applications that can connect to Monitoriza and access variables for use. (This 
service is only available in the Monitoriza Professional version and above). 
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INSTALL  

 
Monitoriza has a very simple installation. It consists of two files, setup.exe and 
Installation Monitoriza.msi. Double clicking on setup.exe and installation begins.  
 
Monitoriza require the. Net Framework Ê Windows Ê 3.5 SP1; if that is not installed 
you will get the following dialog window: 
 

 
Illustration 1 - .Net Framework 3.5 SP1 

  
In which we are asked for the License Agreement of .Net Framework from Microsoft.  
 
Then, install proceeds to download from the Microsoft website and install the 
appropriate package 
 

 
Illustration 2 ó.Net Framework 3.5 SP1ô Download 
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Once installed, start the installation of the Monitoriza main module: 
 

 
Illustration 3 ï Welcome screen 

 
Clicking on the Next button appears the custom installation screen, in which we can 
select the system elements that we want to install. These elements are the Editor , 
that lets you create and modify our Scada forms, the Client , which set the 
environment for project implementation and SCADA Communication Server , for 
establishing communications with both the OPC servers(and  databases) and PLC. 
 

 
Illustration 4 ï Custom setup 
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On the next screen we will click on the Install button to start the installation process 
itself: 
 

 
Illustration 5. Setup complete 

 
Acimut Monitoriza is compatible with operating systems Windows Ê 7, Vista, XP, 
2003 and 2008 the only requirement is to have installed .Net Framework 3.5 SP1 
Microsoft. 
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EDITOR 
 
Acimut  Monitoriza Editor is one of the three main components of the system, with 
it we can create, design and modify our scada projects that are then executed 
through the Communications Server and Client Scada .  
 
When you create or modify a scada project, using the publisher you can define 
variables and alarms, create forms to graphically display the values of the variables, 
store in a database the values of variables, keep a history of alarms, graphically 
show the variable values stored, write variables on a PLC (or other devices) and 
manage who can access the project resources.  
 
The Editor User  int erface  is what can be seen in the two following illustrations: 
 

 
Illustration 6- Editor 1 
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Illustration 7 ï Editor 2 

 
Let's see in some detail each part of the user interface.  
 
At the top is the menu bar and toolbar with standard elements such as operations to 
open or save a project, editing operations (copy, cut, paste ...) and operations for 
formatting and alignment. 
 

 
Illustration 8 ï Menu bar and toolbar 

 
On the sides are browser windows of the project, the toolbox, the server features 
and variables and the properties window. 
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The project explorer window shows the list of forms that conforms our project and 
with a double click we can display the form in question, we may also use the context 
menu to perform certain operations on the forms, as illustrated in next image. 
  

 
Illustration 9 ï Project explorer window 

 

The ToolBox window allows us to add components to forms, with these components 
we design the forms and give them the desired functionality, or use components that 
allow us to view or modify the variables or parameters that we want to monitor 
(Scada tab) or components used to control the flow of application and define its 
design or appearance (Layout and Windows tab). 
 

       
Illustration 10 ï Toolbox 

 
The window of features and server variables allows us to define parameters for each 
communication server that we define in the project, such as the IP address of the 
PLC with which we communicate and the characteristics of groups and variables 
defined on each server. 



 

 MONITORIZA  

 

User Manual Pag: 13 

      
Illustration 11 ï Server & Variables property window 

 

 
In the Properties window we can define the characteristics of each of the 
components added to the forms, for example in the following figure we see that 
selecting the IndicadorNumerico component in the properties window will show the 
characteristics or properties of that component particularly 
 
 

 
Illustration 12 ï Control Property window 

 
Keep in mind that although the windows are arranged on the sides, this layout is 
configurable, and simply dragging over the title of the window  we can position them 
more conveniently for our work. 



 

 MONITORIZA  

 

MONITORIZA ï ACIMUT S.L. PAG: 14 

 
 

 
Illustration 13 ï Forms & Windows repositioning 

 
Demo : http://www.acimut.com/monitoriza/videos/editor1/default.html 
 
Also, the windows for Variables, Properties, Toolbox and Explorer can set for 
automatically hide when they lost the focus making the work surface larger, simply 
clicking on the corresponding button on the window title (marked in red in the 
illustration below) the window hiddes when lost the focus. To re-view, move the 
mouse over the tab that represents the window is visible and if we want to stop 
hiding again press the same button to fix your position. Positioning settings of each 
window is stored with each project and when we reopen a particular project, the 
windows are positioned as they were when we saved the project. 

http://www.acimut.com/monitoriza/videos/editor1/default.html
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Illustration 14 ï Auto hide a window 

 
Demo : http://www.acimut.com/monitoriza/videos/editor2/default.html 
 
In the Tools menu we have a couple of options that help us in design tasks 
 
In this menu we have the Options item: 
 

 
 
The options of this menu are: 
 
Layout Mode:  We can choose between Snaplines (default) that uses the advanced 
positioning features of Microsoft applications; the other possible value is Grid, in 
order to use the classical grid, allowing us to set the size between dots using 
GridSize property.  
 
We can choose the options for the grid using the properties: 
ShowGrid: Show or hide the grid in design mode. 
SnapToGrid:  If we want to snap the controls to the grid or not. 
 

http://www.acimut.com/monitoriza/videos/editor2/default.html
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CREATE A PROJECT  

STARTING... 
 
To create a project using the Monitoriza editor, at least we must define a 
communications server with PLC, the variables that we want access to, that will join 
in groups, and at least one form for designing the user interface of the project.  
 
Additionally we can set alarms that are triggered with the conditions that we define, 
users and permissions to establish form access to each of the defined user.  
 
In the definition of servers we can also set the database server where we store 
permanently the values of the variables we monitored.  
 
Here's how to do each task. To start the Monitoriza Editor we will have to start a new 
project by clicking on the New Project  option from the File menu . 
 
 

 
Illustration 15 ï New Project menu 

 
Or else clicking the New Project  button in the toolbar. 
 

 
Illustration 16 ïNew Project toolbar icon 

 
Then we define the communication servers with PLC and databases, either by 
clicking on the View menu option Servers 
 

 
Illustration 17 ï Servers Menu 

 
Or Servers button in the Variables window 
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Illustration 18 - Servers 

 

And we will get the dialog for the definition of the servers. 
 

 
Illustration 19 ï Server Definition 

 
Demo : http://www.acimut.com/monitoriza/videos/definir_servidores/default.html 
 
A new project needs at least one server, here is the list of different server types.  
 
Monitoriza have native communication servers with PLCs (Modbus RTU, Modbus 
TCP and ISO Simatic S7) and third party servers as OPC, this allows you to connect 
a multitude of devices.  
 
If you want to store a history of variable values and/or a history of alarms that occur 
in the system, we define one or more database servers in which we will establish the 
database used. The definition of data servers will be shown in detail in Section Save 
Database  
 
Another possibility is to define an internal data server (Server Type: Interno), by this 
server can specify a set of variables that are independent of the variables of the PLC 
but can serve to store values such as configuration parameters or values calculated. 
 
Each communication servers with the PLC will have different properties as 
discussed below. 

http://www.acimut.com/monitoriza/videos/definir_servidores/default.html
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ModBUS RTU  
The different properties of a MODBUS RTU server 
type are shown below.  
 
These properties set the parameters for serial 
communication and the number of slave to connect 
to a ModBUS environment. It should be noted that 
Monitoriza establishes connections ModBUS as a 
master. 

 
Illustration 20 - RTU 

  

ModBUS TCP  
The properties of a MODBUS TCP server type:  
 
Are the IP address of Modbus devices, in an 
Ethernet environment is needed; and the number of 
slave to connect to a ModBUS environment. It 
should be noted that Monitoriza establishes 
connections ModBUS as a master. The use of slave 
number allows access gateways. 

 
Illustration 21 - TCP 

  

OPC 
OPC stands for OLE for Process Control, it 
is a standard defined by Microsoft which 
aims to unify methods of communication with 
all types of devices because of its good 
acceptance by various manufacturers, we 
can say that there is an appropriate OPC 
server for any device that is in the market.  
 
The properties that allow us to connect to an 
OPC server are as follows: 
 

 
Illustration 22 - OPC 

We begin by describing the last of these properties, the Type, this is the name that the 
manufacturer has given its OPC server, a dropdown will allow us to choose between the 
OPC server installed on your machine or in a computer in our network using Node (you 
must have the proper permissions, it is operating system dependent, there is abundant 
documentation on this subject that its outside the scope of this manual). The property is 
vendor-specific driver, we must consult the documentation for each OPC server, is a prefix 
that usually defines how we communicate with the PLC and its direction and characteristics.  
 
In the next chart we can see some examples. 
 

Fabricante Tipo  Driver  Variable 
Siemens S7-200 S7200.OPCServer 192.168.100.120:1200:1001, VW1000,INT,RW 

Telemecanique Schneider-
Aut.OFS.2 

UNTLW01:0.254.0! %MW2000 

  MBS03:1/T! %MW2000 

  XIP01:192.168.1.2.10.2! %MW2000 
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Simatic ISO S7  
The properties of a server type Simatic S7 ISO are:  
 
Are the Simatic device IP address, the number of 
CPU Rack (usually 0), and the slot in the Rack, in 
which lies the CPU (usually the 2). 
 

 
Illustration 23 - Simatic 

  
 

OPEN AND SAVING PROJECTS  
 

 
On the File menu options are typical Open ..., Save and Save As ... to allow us to 
open previously saved projects and save the changes that we make to our projects. 
These operations can also be done from the toolbar. 
 

   
   

                       

CREATE VARIABLES  

 
The variables in Acimut Monitoriza are the basic element of information, with them 
we set the bond between the tags and records of the PLC and the various 
components of our project, enabling the visualization and modification of the different 
elements that we monitored.  
 
The variables are ultimately what we will be measuring or monitoring, including 
temperature, pressure, voltage, open or closed status of any of the devices of our 
process. 
 
Each Monitoriza variable is defined by three different elements: 
 
The communications server , which refers to the PLC that manages and controls 
the device or devices on which we operate or control.  
 
The group , which is a grouping of variables depending on the characteristics of 
these, for example by combining the variables that we are only interested to read in 
a group and others we want to read and write in another, or if we have a group of 
variables we must read with a different cadence from other variables grouped into 
different groups. It is also important to consider the communication protocols, so, 
when we read a set of records, such records in contiguous PLC memory positions, 
reading, either by an OPC server or a server ModBUS, is more efficient if we put the 
adjacent records in the same group and will improve the performance of our SCADA.  
 
Name is the symbolic name we give to record the PLC. 
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Therefore to create variables once we have established communications servers as 
we saw in the previous chapter, we must create the groups to which the variables 
will belong 
 

To do this, in the server window click on the three points of the Groups property 
 

  
Illustration 24 ï Create/Edit groups 

 
Depending on the type of server, group characteristics are similar but with some 
difference, so we'll see each in detail. 
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Groups  ModBUS TCP and ModBUS RTU 
 

 
Illustration 25 ï ModBUS TCP & ModBUS RTU Groups 

 
The properties that define a group of a MODBUS TCP server are: 
 

¶ GroupType: Group type, indicates whether the variables are of a register type 
or bit. Select ReadHoldingRegisters when the variables are read / write register 
(a word, 2 bytes), and ReadCoilStatus type for bit variables . 

¶ IsSubscribed:  Indicates that this group of variables is read continuously. If we 
define a group with only variables that will be written and not will be readed we 
can leave this property to False value. 

¶ Name: Is a text describing the contens of the Group, for organization purposes 
is better to set a descriptive text. 

¶ UpdateRate:  In case of IsSuscribed is set to True this property indicates the rate 
in milliseconds for reading the contents of a group. Is appropriate to adapt the 
value of this property to the communication type and protocol. 

¶ Variables : Is the property through which we can enlist the variables used. Will 
see this property in more detail later. 
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OPC Group 
 

 
Illustration 26 ïOPC Group 

 
The properties that define a group of an OPC server are:  
 

¶ IsSubscribed:  Indicates that this group of variables will be read continuously. If we 
define a group with only variables that will be written and read is not needed, leave 
this property to False.  

¶ Name:  Name of the group and should be as descriptive as possible for 
organizational reasons.  

¶ UpdateRate:  If is suscribed property is True, will indicate the rate for reading in 
milliseconds for each group. It is advisable to adpat this value to the type of 
communication available.  

¶ Variables : The property through which we can enlist the variables used.  
 
Once we have defined the group we can define variables or records, to do it in the 
same window, we have the property Variables  in which, if we click on the three-point 
button property, appears the definition window for variables or registers. 
 

 
Illustration 27 ï Create/Edit variables 
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This has the following properties: 
 

¶ Active Alarms : Indicates whether to activate alarms for that variable. We show 
in more detail in the next chapter. 

¶ Value  Type: Sets the size of the variable. The options are: Single_Word (2 
bytes) and Double_Word (4 bytes) 

¶ Sign : Defines whether the variables are considered signed or unsigned. The 
options are: UnsignedInteger - unsigned integer and SignedInteger - signed 
integer 

¶ Name: The symbolic name we give to the variable. Must consist of alphanumeric 
characters and contain neither spaces nor symbols. 

¶ PLC Variable : Identifies the PLC register and must follow the rules and 
conventions for the selected plc type. 

¶ Scaling : Indicates that the value of this register is scaled, i.e. we can specify the 
maximum and minimum values for scaling analog values, for example, if we 
have a record that will give us the input value of a probe, and on the one hand 
we have a signal of 12 bits and the other a probe 4-20 mA. measuring 
temperatures between -40 º C to 60 ° C we should configure these properties 
this way: 

 

 
 

 
 By this way, we have the value scaled, keep in mind that scaled value is used for 

alarms, recipes, etc. But values in simulation arenôt scaled. A lineal scaling is 
used. 

 

¶ Simula tion Type : When 'running' a project in design mode, this option allows 
you to automatically change the value of the variables. If you choose any type 
that not is  manual simulation weôll see the following three properties. 

¶ Maximum value : Is the maximum value that the simulation system will give to 
the variable. 

¶ Minimum value : Is the minimum value that the simulation system will give to the 
variable. 

¶ Period value : It is the time, in seconds, of each cycle or state, will influence the 
changing speed of the value of the variable. 

 
There are simulations for random, incremental, decremental, Square Wave, Sine 
Wave and Triangular Wave. We see in the picture below an example of waves 
generated by monitoriza and the signal period for the square wave. 
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Value Type property and Sing  property only appear when the group is MODBUS 
TCP or MODBUS RTU and the kind of group canôt be defined as ReadCoilStatus 
since this type involves a bit of a internal coil. 
 
Demo : http://www.acimut.com/monitoriza/videos/crear_variables/default.html 
 
Once we have created the groups and variables can also edit them by selecting the 
corresponding variable or group of variables in the tree at the top of the window 
variables and editing their properties in the lower pane of the window. 
 

   
Illustration 28 ï Edit groups & variables 

   
 

Variables Event  
 
Once we have defined a variable we can set the alarms associated with that variable 
as discussed in the next chapter (alarms) or control the valueChanged event of the 
variable. 
 
By both methods we are able to perform actions when the value of a variable 
changes. 
 
We will use the alarm method when we want to get a notification for a certain 
condition for the value of the variable and will use a valueChanged event when we 
want to take an action simply because the value has changed. 
 
To set the valueChanged event we must click on the Events button properties 
window for the variable (marked in red in figure). 

http://www.acimut.com/monitoriza/videos/crear_variables/default.html
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Illustration 29 ï Activate event window 

 
Once in the event window we must click the three dots button. 
 

 
Illustration 30 ï Variable event 

 
A code editing Windows will be displayed in order to set the action to perform when 
the value of the variable changes. 
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Illustration 31 ï Code Events Editor 

 
Our code will run on the communications server of Monitoriza therefore we have 
access to all resources on the server where is installed. 
 

 

ALARMS  

Create Alarms  

Whenever we want the Scada system notifies us of a certain condition we must set 
an alarm. These alarms can check for example if a temperature is above or below a 
certain value, the pressure has reached a value or any other aspect that we want to 
consider. 
 
Alarms are associated with variables and, are in the variable definition window 
where we establish if we bind a variable to an alarm. To do this, when creating or 
editing a variable we must set to True the property Active Alarms , then the Alarms  
property will appear and by hitting the button with three points we can define the 
alarms associated to the variable. 
 

 
Illustration 32 ï Alarm creation 

 
Associated with a variable we can define one or more alarms depending on the 
conditions we want to control. 
 
We must set the message we want to show when defining the alarm, if we store the 
event to keep track of which has occurred or if a user needs to validate the alarm, 
and the conditions in which an alarm should be fired. 
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We can make the evaluation of the alarms by comparison of the variable in which 
the alarm is set with a constant value (eg the temperature is less than 40) or may be 
interested to compare the variable that is defined in the Alarm system with another 
variable (eg if you are monitoring the production of various products can be stored in 
a variable that you want to fire the alarm temperatures depending on the product we 
are producing). Set the property to Constant or Variable TypeValue respectively for 
either case. 
 
Additionally we can define a group of alarms using the AlarmGroup property, this 
group of alarms is used to specify user-level permissions, or define the users that 
will see that alarms or if they can validate or not as seen in the chapter Users and 
Permissions. 
 

 
Illustration 33 ï Alarms property window 

 
Let's look in detail by examining each of the properties of the alarm. 
 

¶ Store : Defines if the alarm will be stored. In order to store the alarms we must to 
define an additional database server with the property Alarms established. 

¶ Alarm Message : Alarm message displayed when activated. 

¶ AlarmGroup: Permission group linked to the alarm. 

¶ Valid ate: If set to True, will require a user to validate in order to hide it in the 
window display when no alarm is active. For a properly work in validation it is 
necessary to store the alarm. We will see how to define the database, table and 
fields in the Save Database point. 

¶ Evaluate by : Sets the comparison condition that determines when the alarm is 
active. The possible values are: Equal, MoreThan, LessThan and Distinct. 

¶ TypeValue:  The possible values are constant and variable. Constant is used if 
the EvaluateBy property is to compare a absolute value, this value is defined in 
the value property. If we want to fire the alarm comparing whith another variable 
in the system we must to set the TypeValue property to Variable and the 
properties Server, Variable and Group will be used to set the variable used in the 
comparation. 

¶ Value: Set the value to apply the condition evaluation for the alarm. For example 
if we are monitoring the temperature and we define the property value to 40 and 
assesses property for a GreaterThan, we activate the alarm if the temperature 
value exceeds the value of 40. 
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¶ UseBit:  It allows us to use in isolation of the bits of the variable in the 
assessment given (first bit is 0). Clearly, in this case, we can only compare with 
the values 0 and 1. 

¶ Server, Group and Variable:  Set the system variable that we will use for 
comparison when the TypeValue is set to Variable. 

 
Scada property group allows us to specify the variable value for storage in the 
database and therefore for display in the Alarm Viewer. 
 

¶ Divider : Display the variable value divided by the number indicated in the 
property. 

¶ Multiplier : Display the variable value multiplied by the number indicated in the 
property. 

¶ Format : Change the appearance of the value of the variable, for example a 
format equal to # # .00 variable will cause the display with two decimal places. 

 
Demo : http://www.acimut.com/monitoriza/videos/crear_alarmas/default.html 
 

 

Alarms  Viewer  
 
The alarm display is the centerpiece of notification and validation of alarms that 
occur in SCADA project implementation. 
 

 
Illustration 34 ï Alarm viewer 

 
Whenever an alarm fires, because the conditions stablished in design have been 
fullfilled, the display shows alarm, the possible states of the alarm, depending on if 
you have set as you need validation or not and these states are represented by 
different colors. 
 

¶ Red: Indicates that the alarm is active and requires validation, that is, we must 
click on the Validate button to indicate that a user has ignored the alarm and 
took the appropriate action. 

 
¶ Pink : Indicates that the alarm is active and has been validated, i.e. a user has 

clicked on the SCADA Validate button. 

 
¶ Yellow : Indicates that the alarm is no longer active but has not yet been 

validated. 

http://www.acimut.com/monitoriza/videos/crear_alarmas/default.html
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¶ Blue : Indicates that the alarm is active and does not require validation. In this 

case not requires validation and disappears at the moment the alarm is no 
longer active. 

 
 
Demo : http://www.acimut.com/monitoriza/videos/validar_alarma/default.html 
 
 

Alarm Events  
 
Alarm Events is one of the more important extensibility elements in Monitoriza.  
 
Using the Alarm Viewer, described in the previous section, we have seen that we 
have the opportunity to be notified whenever an alarm occurs and we can validate it, 
if it is defined that way, so the alarm will appear until the alarm is validated even if 
the alarm condition no longer occurs.  
 
The problem is that the Alarm Viewer notify us via a popup window, in the operation 
post, that the alarm has occurred, and therefore if you are not controlling the screen 
not we realize the alarm.  
 
To solve this issue we have the alarm events, that can be defined as procedures that 
are triggered in the server of Monitoriza, whenever an alarm is initiated, completed 
or validated.  
 
The typical use of these events is to send a notification that the alarm has entered 
into a certain state, for example by sending an email or SMS message. Thus, if we 
are controlling, for example, temperature, and this exceeds a certain value we can 
send a message to a particular phone or an email message indicating that the 
temperature has exceeded the preset value.  
 
While this is a typical use, the truth is that we can do a wide range of actions when 
an alarm is set (launch a process in the server, or stop it, record in a database, 
invoke a service external to our system ...) so how Monitoriza allows you to define 
procedures to be fired when the alarm starts, ends or is validated is programming 
the procedure in C # or VB.NET.  
 
Let's see how to do this:  
 
From the Alarms Editor window, we must select the alarm to which we assign events 
 

http://www.acimut.com/monitoriza/videos/validar_alarma/default.html
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Illustration 35 ï Alarms Editor 

 
Clicking the Events button (in red in the picture) will show the next window 
 

 
Illustration 36 ï Alarms Events 

 
In this Window are three events: AlarmStarts, AlarmEnd and AlarmValidated, that 
are the events that will be fired when an alarm situation is started, ended or 
validated. 
 
We can bind code to one event or to all. For example, to bind code to the event 
AlarmStarts we must click over the three dots button (in red in the illustration) in 
order to open the code editor for the event. 
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Illustration 37 ï Code Events Editor 

 
 
In the Code Editor of Events, we can write code in both C # and in VB.NET, by 
simply selecting the appropriate menu. 
 
Left panel shows the list of servers, groups and variables that we have defined, 
having the ability to drag and drop any of the variables on the editor window in order 
to pick up their value or change it. 
 
Here's an example of code used to send an email using a gmail.com account. In the 
example we can see that consists in creating a SmtpClient object to set the 
connection to the mail server, a MailMessage object that allows us to identify the 
sender, recipients, subject and message body. In the example we use the value of 
the variable Registro1  to compose the message body in the property 

MyMailMessage.Body . 

 
 

 
Imports System  

Imports System.Drawing  

Imports System.Data  

Impor ts System.Xml  

Imports System.Windows.Forms  

Imports Microsoft.VisualBasic  

Imports System.Net.Mail  

Namespace Scada  

    Public Class Monitoriza  

        Public Sub AlarmStarts( ByRef clsVariables As object )  

           Try  

                'Start by creating a ma il message object  

                Dim MyMailMessage As New MailMessage()  

                 

                'From requires an instance of the MailAddress type  

                MyMailMessage.From = New MailAddress("remitente@gmail.com")  

                 

                'To is a collection of MailAddress types  

                MyMailMessage. To.Add("destinatario@dominio.com")  

                 

                MyMailMessage.Subject = "  Start Alarm Grupo1, Registro1"  
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                Dim strBody As String  

                strBody = String .Format("{0}. The variable Grupo1, Registro1 has 

reached the value {1}",  Now(),  clsVariables.Variables(  "ModBusTCP1",  "Grupo1",  

"Registro1",  ""))  

 

                MyMailMessage.Body = strBody  

                 

                'Create t he SmtpClient object and specifies the user's credentials  

                Dim SMTPServer As New SmtpClient("smtp.gmail.com")  

                SMTPServer.Port = 587  

                SMTPServer.Credentials = New 

System.Net.NetworkCredential("usuario@gmail.com" ,  "contraseña")  

                SMTPServer.EnableSsl = True  

         

                'Send the message  

                Try  

                  SMTPServer.Send(MyMailMessage)  

                Catch ex As SmtpException  

                   MessageBox.Show("Ex1=" & ex.Message)  

                End Try  

            Catch ex2 As SmtpException  

               MessageBox.Show("Ex2=" & ex2.Message)  

            End Try  

        End Sub  

    End Class  

End Namespace  

 
 
 
 

 

CREATE FORMS 

 
In Acimut Monitoriza Scada to create a project the minimum needed is to define the 
communication servers  with PLC and the user interface.  
 
To create the user interface  we can design as many forms as we need for our 
project and for this we will add any of the controls that are displayed in the Toolbox 
window, in any of the tabs: Scada, Design, Windows and User Controls. Also, we 
can add controls by dragging, directly from the Variables window, the desired 
variable as we can see in a later example. 
 
To add a form to a project, click the button on the toolbar shown below. 

 
 
Or select New Form  from the File Menu  
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Now, the Monitoriza Editor looks like: 
 

 
Illustration 38 ï Monitoriza Editor 

 
Now, we have a new form and its properties on the right.  
 
Also note that now we have enabled the editing tools in the toolbar.  
 
Additional forms will be created in new tabs, and also in the Explorer tree on the 
right. Closing a tab does not involve deleting a form. 
 

 
Illustration 39 ï Project Explorer treeview 

 
The Project Explorer allows, with double click, open a form and using a contextual 
menu Delete, Export and Import forms. 
 
Demo : http://www.acimut.com/monitoriza/videos/crear_formularios/default.html 
 
As mentioned above, to add controls to the form, we can drag them from the 
ToolBox window, as shown int the next illustration. 

http://www.acimut.com/monitoriza/videos/crear_formularios/default.html
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Illustration 34- Drag a control from the Toolbox window 

 
Or drag a variable from the Variables window, as shown in the illustration. 
 

 
Illustration 40 ï Drag a control from the Variables window 

 
Dragging a variable has the advantage that in the same operation we are doing two 
actions, on the one hand we are designing the form by setting the necessary 
controls and on the other hand we are assigning directly the Server, Group and 
Variable properties. 
 

 
 
By default, dragging a variable, creates a Text control, but clicking on the variable 
name we can change the control type associated to the variable, choosing the 
appropriate type from the dropdown list that appears. 




































































































































